
Computing Year 5 2016 - 2017 

Unit 5.6  We are Architects               Step 1: Exploring art galleries                                Karin Clark 
Learning Expectations Main Session Resources and e-safety 

This unit will enable the children to: 

 understand the work of architects, designers 
and engineers working in 3D 

 develop familiarity with a simple CAD 
(computer aided design) tool 

 develop spatial awareness by exploring and 
          experimenting with a 3D virtual environment 
          develop greater aesthetic awareness. 

Share the Learning expectations for the unit  

and explain the success criteria. 
 
Tell the pupils that they are going to create a virtual art gallery 
in which to display their artwork. 
 

Model the interface for Google Art Project. Click Collections 
to view a list of museums and select one that provides a 
virtual tour (e.g. the National Gallery in London). Invite pupils 
to explore some of the galleries for themselves. Ask them to 
investigate common features of these galleries, as well as 
finding examples of art gallery architecture and design they 
think is especially effective. Encourage them to look at how 
the art is displayed. How are the paintings grouped together? 
How much space does each have? 
 
Brainstorm the characteristics of art galleries. Invite children 
to continue their investigations using Google, encouraging 
them to look at galleries or museums in other countries. 
Bringing the class back together, refine the list of 
characteristics in the light of the pupils’ research, and collate 
the examples they provide. You could use these as additional 
success criteria for the project. 
 
Ask pupils to sketch a few initial design ideas for their virtual 
gallery on paper, or build models from construction materials. 

The usual precautions should be followed when 
the pupils are using the internet for their research; 
this includes searching for objects in Trimble’s 
online warehouse. 
 
If the pupils will be sharing their creations online, 
follow all the relevant school policies, taking 
particular care to limit the sharing of personal 
information. 
 
If using Google Earth to locate real or imaginary 
buildings, the pupils should not share the location 
of their home, and you should check with your 
school leadership team before sharing the location 
of the school. 
 
When uploading examples of work to the virtual 
gallery, respect the intellectual property of 
the original artists, acknowledging sources by 
attaching virtual labels to the work. 

 

Google Art Project: 
www.googleartproject.com 
 
Virtual tour of the National 
Gallery, London: 
www.google.com/culturalinstitute/ 
collection/the-national-gallerylondon? 
museumview&projectId=artproject 
 
Virtual art gallery: www.3dvas.com 
Some contemporary gallery 
architecture: www.e-architect.co.uk/ 
art_gallery_buildings.htm 

Curriculum links in this Unit 

Literacy  

Numeracy  

Science  

Art & Design  

Music  

DT  

Geography  



Computing Year 5 Computing Year 5 2016 - 2017 

Unit 5.6                                     Step 2: Creating a virtual sculpture Karin Clark 
Learning Expectations Main Session Resources and e-safety 

This unit will enable the children to: 

 understand the work of architects, designers 
and engineers working in 3D 

 develop familiarity with a simple CAD 
(computer aided design) tool 

 develop spatial awareness by exploring and 
          experimenting with a 3D virtual environment 
          develop greater aesthetic awareness. 

Introduce the pupils to SketchUp and then ask them to 
explore the interface for themselves. Encourage them to share 
what they discover with one another. 
 
Demonstrate how to navigate the 3D environment using the 
orbit, pan and zoom tools on the standard toolbar. Show how 
to bring up the large tool set and demonstrate the walk and 
look around tools. Encourage pupils to experiment with these 
further themselves. 
 
Demonstrate how to draw 2D shapes and extrude these into 
3D. Encourage the pupils to experiment with this and share 
their discoveries with one another. 
 
Show how to select objects, faces and edges. Show how 
each of these can be moved, and encourage the pupils to 
experiment with these techniques further. 
 
Show pupils a few online examples of geometrically inspired 
sculpture, such as that of Barbara Hepworth, Carl Andre and 

John Robinson (see the links in Resources). You may also like 

to remind them of the work created in Unit 5.3 – We are artists. 
Ask the pupils to use SketchUp to create a simple geometric 
sculpture. Some pupils may benefit from first making a 
sculpture using building blocks before recreating it as closely 
as possible in SketchUp. 
 
Encourage the pupils to request and provide feedback from 
one another on their SketchUp sculptures, and give them time 
to refine them in the light of this feedback. 
 
If time is available, show a video about 3D printing (see 

Resources). Discuss how this technology works, and ask the 

pupils to suggest some possible applications. 

The usual precautions should be followed when 
the pupils are using the internet for their research; 
this includes searching for objects in Trimble’s 
online warehouse. 
 
If the pupils will be sharing their creations online, 
follow all the relevant school policies, taking 
particular care to limit the sharing of personal 
information. 
 
If using Google Earth to locate real or imaginary 
buildings, the pupils should not share the location 
of their home, and you should check with your 
school leadership team before sharing the location 
of the school. 
 
When uploading examples of work to the virtual 
gallery, respect the intellectual property of 
the original artists, acknowledging sources by 
attaching virtual labels to the work. 

 

SketchUp tutorials: www.sketchup. 
com/learn/videos?playlist=58 and 
www.youtube.com/watch?v=y9PEdm 
fW7Ig&list=SP2A29A6B9E312A112 
 
3D printing video: www.ted.com/ 
talks/lisa_harouni_a_primer_on_3d_ 
printing.html 
 
Geometrically inspired sculpture: 
http://barbarahepworth.org.uk, www.carlandre.net, 

www.bradshawfoundation.com/jr 

Curriculum links in this Unit 

Literacy  

Numeracy  

Science  

Art & Design  

Music  

DT  

Geography  



Computing Year 5 Computing Year 5 2016 - 2017 

Unit 5.6                                     Step 3: Creating a prototype of the game                        Karin Clark 
Learning Expectations Main Session Resources and e-safety 

This unit will enable the children to: 

 understand the work of architects, designers 
and engineers working in 3D 

 develop familiarity with a simple CAD 
(computer aided design) tool 

 develop spatial awareness by exploring and 
          experimenting with a 3D virtual environment 
          develop greater aesthetic awareness. 

Ask the pupils to begin work on their virtual galleries Encourage 
pupils to review their sketches from Step 1, 
revising them in the light of what they’ve learned. 
 
Suggest that it’s best to concentrate on the main room of 
the gallery, adding other rooms if time permits. Ask pupils to 
sketch out a ground plan for their gallery in SketchUp. 
 
The pupils should then add individual walls to the gallery, 
possibly leaving one wall until later to make access to the 
interior of the space easier. Remind them that normally the 
walls will all be the same height. They should create gaps in 
the walls for doors and, if they wish, windows. 
 
Encourage the pupils to review one another’s galleries at this 
point, revising them on the basis of the feedback received. 
The pupils could use the navigation tools in SketchUp to 
explore their gallery from different perspectives. 
 
Demonstrate how to add a ceiling, and how to cut holes in 
the ceiling to create skylights. 
 
If time permits, the pupils could add further rooms to their 
gallery, connecting them with doorways and/or corridors, 
staircases and lifts. Ask them to get further feedback on their 
galleries, making modifications based on this. 
 
The pupils could explore the texture options for the surfaces 
they create, keeping in mind that they will be hanging their 
artwork on the walls. 
 
Ask the pupils to pay attention to both the internal and 
external features of their space. Some feedback from you 
and their classmates at this stage would be useful. 

The usual precautions should be followed when 
the pupils are using the internet for their research; 
this includes searching for objects in Trimble’s 
online warehouse. 
 
If the pupils will be sharing their creations online, 
follow all the relevant school policies, taking 
particular care to limit the sharing of personal 
information. 
 
If using Google Earth to locate real or imaginary 
buildings, the pupils should not share the location 
of their home, and you should check with your 
school leadership team before sharing the location 
of the school. 
 
When uploading examples of work to the virtual 
gallery, respect the intellectual property of 
the original artists, acknowledging sources by 
attaching virtual labels to the work. 

 

Trimble SketchUp training video 
for this step: www.youtube.com/ 
watch?v=hIXsuOjk7gs 

Curriculum links in this Unit 

Literacy  

Numeracy  

Science  

Art & Design  

Music  

DT  

Geography  



Computing Year 5 Computing Year 5 2016 - 2017 

Unit 5.6                                   Step 4: Adding furniture to the gallery                               Karin Clark 
Learning Expectations Main Session Resources and e-safety 

This unit will enable the children to: 

 understand the work of architects, designers 
and engineers working in 3D 

 develop familiarity with a simple CAD 
(computer aided design) tool 

 develop spatial awareness by exploring and 
          experimenting with a 3D virtual environment 
          develop greater aesthetic awareness. 

Ask pupils to look back at the images or tours of art galleries 
that they explored in Step 1, this time focusing on the 
furniture, fixtures and fittings of these spaces. Ask pupils to 
compile a ‘shopping list’ of all the furniture they might need. 
 
Ask the pupils to list, or sketch, a few ideas for the furniture 
they would like inside their gallery. Introduce them to the 
3D Warehouse on SketchUp, and ask them to search for 
examples of, for instance, benches. Ask them to think 
carefully about how the search engine in the 3D Warehouse 
(provided by Google) selects and ranks the results. Spend 
some time discussing this. Ask the pupils which bench would 
look best in their gallery. Ask them to think about what criteria 
they will use to make this decision. 
 
Demonstrate how to import a bench into a gallery and 
position it appropriately (File > 3D Warehouse > Get 
models, then search, select, download and simply position). 
Demonstrate how copy and paste work so that the pupils 
can add more than one bench if they want to. Show how the 
bench can be rotated horizontally if needed. 
 
Ask the pupils to spend time adding appropriate furniture, 
fixtures and fittings to their gallery from the 3D Warehouse. 
Encourage the pupils to think of the overall style and design 
of their gallery, and to be selective in choosing furniture 
and fittings for it. Remind them that the furniture should not 
detract from the art. 
 
Provide an opportunity for pupils to critique one another’s 
choices, and allow them to replace furniture if they are 
unhappy with their original choice. 

The usual precautions should be followed when 
the pupils are using the internet for their research; 
this includes searching for objects in Trimble’s 
online warehouse. 
 
If the pupils will be sharing their creations online, 
follow all the relevant school policies, taking 
particular care to limit the sharing of personal 
information. 
 
If using Google Earth to locate real or imaginary 
buildings, the pupils should not share the location 
of their home, and you should check with your 
school leadership team before sharing the location 
of the school. 
 
When uploading examples of work to the virtual 
gallery, respect the intellectual property of 
the original artists, acknowledging sources by 
attaching virtual labels to the work. 

 

Google Art Project: 
www.googleartproject.com 
 
Some contemporary gallery 
architecture: www.e-architect. 
co.uk/art_gallery_buildings.htm 
 
See www.youtube.com/ 
watch?v=GTDoLfECkgU for a 
tutorial on the 3D Warehouse 
Trimble SketchUp training video 
for this step: www.youtube.com/ 
watch?v=lahlYgNIr2c 

Curriculum links in this Unit 

Literacy  

Numeracy  

Science  

Art & Design  

Music  

DT  

Geography  



Computing Year 5 Computing Year 5 2016 - 2017 

Unit 5.6                                                     Step 5: Hanging art                                               Karin Clark 

Learning Expectations Main Session Resources and e-safety 

This unit will enable the children to: 

 understand the work of architects, designers 
and engineers working in 3D 

 develop familiarity with a simple CAD 
(computer aided design) tool 

 develop spatial awareness by exploring and 
          experimenting with a 3D virtual environment 
          develop greater aesthetic awareness. 

Ask the pupils to browse through their home directories/ 
e-portfolios/blogs for any examples of digital artwork that 
they could display in their virtual gallery. This could include 

examples from Unit 5.3 – We are artists. 
 
If the children have other, non-digital, artwork in school 
or at home that they’d like to include, they can take 
photographs of this or use scanners to produce digitised 
versions. It’s normally quicker and more flexible to use digital 
photographs, and you may need to show the children how to 
operate a scanner if they have not used one before. 
 
Ask the pupils to plan the layout of their gallery. Where 
will they hang the various pieces of artwork that they have 
chosen? How will they organise the layout? Discuss possible 
strategies, perhaps considering the path they hope their 
gallery visitors will take around the gallery, or the available 
lighting. 
 
Explain that the work on display need not be restricted to art. 
Their gallery could become an extendable virtual e-portfolio. 
Model how to import images or PDF files to the gallery (use 
File > Import, select the file type and choose Use as image). 
The pupils should import and place their work on the walls 
of their gallery, experimenting with different layouts. At this 
point they may need to add the final wall, if they have not 
already done so. 
 
Remind the pupils that they should also add the sculpture 
they created in Step 2, again using File > Import. 
Encourage the pupils to share their galleries with one 
another, making changes to the layout and contents on the 
basis of the feedback they receive. 

The usual precautions should be followed when 
the pupils are using the internet for their research; 
this includes searching for objects in Trimble’s 
online warehouse. 
 
If the pupils will be sharing their creations online, 
follow all the relevant school policies, taking 
particular care to limit the sharing of personal 
information. 
 
If using Google Earth to locate real or imaginary 
buildings, the pupils should not share the location 
of their home, and you should check with your 
school leadership team before sharing the location 
of the school. 
 
When uploading examples of work to the virtual 
gallery, respect the intellectual property of 
the original artists, acknowledging sources by 
attaching virtual labels to the work. 

 

Trimble SketchUp training video 
for this step: www.youtube.com/ 
watch?v=hPxGAXI4VkE 

Curriculum links in this Unit 

Literacy  

Numeracy  

Science  

Art & Design  

Music  

DT  

Geography  



Computing Year 5 Computing Year 5 2016 - 2017 

Unit 5.6                                Step 6: Creating a virtual tour of the gallery                        Karin Clark 

Learning Expectations Main Session Resources and e-safety 

This unit will enable the children to: 

 understand the work of architects, designers 
and engineers working in 3D 

 develop familiarity with a simple CAD 
(computer aided design) tool 

 develop spatial awareness by exploring and 
          experimenting with a 3D virtual environment 
          develop greater aesthetic awareness. 

 

Tell the pupils they are now going to create a virtual tour 
of their gallery that could be used by people considering 
whether to visit. 
 
Ask the pupils to create different views of their gallery, 
adding these as scenes within a SketchUp animation (use 
View > Animation > Add Scene). They should think in terms 
of using the animation to tell the story of a visit to their 
gallery. Demonstrate how the animation settings can be 
changed to set the duration of each view and the time for 
transitions between views (use View > Animation > Settings). 
Once the pupils are happy with their animations, ask them to 
record a screencast using Screencast-o-matic, ideally with 
a spoken commentary, discussing the artwork displayed 
as well as features of the gallery (such as the furniture or 
skylights) that might be useful for a visitor to know. 
 
The pupils could import their screencast into Movie Maker® 

to edit it further, or use this software to record their narration 
after changing the length of time for some shots. 
Use a final plenary for the pupils to watch the screencast 
tours. If your school’s e-safety policy permits, you could 
upload the tours to the learning platform, class blog or a 
video sharing site. 
 
Invite the pupils to provide each other with constructive 
feedback. They should evaluate the success of their virtual 
space using the criteria for effective gallery design they 
established at the beginning of the unit. 
 
If time permits, the pupils could work together to develop a 
larger ‘meta gallery’, made by combining all the individual 
galleries together to produce a single, shared space in which 
the class’s artwork is displayed. Some pupils could work 
together to produce virtual tours of this space. 

The usual precautions should be followed when 
the pupils are using the internet for their research; 
this includes searching for objects in Trimble’s 
online warehouse. 
 
If the pupils will be sharing their creations online, 
follow all the relevant school policies, taking 
particular care to limit the sharing of personal 
information. 
 
If using Google Earth to locate real or imaginary 
buildings, the pupils should not share the location 
of their home, and you should check with your 
school leadership team before sharing the location 
of the school. 
 
When uploading examples of work to the virtual 
gallery, respect the intellectual property of 
the original artists, acknowledging sources by 
attaching virtual labels to the work. 

Trimble SketchUp training video 
for this step: www.youtube.com/ 
watch?v=hJyLxBgI1NM 

Curriculum links in this Unit 

Literacy  

Numeracy  

Science  

Art & Design  

Music  

DT  

Geography  


